Example name PTSD

Effect size Prevalence

Analysis type Basic, Prediction interval
Level Basic

Synopsis

This analysis includes eleven studies where mothers whose children suffered with chronic illnesses were
evaluated for PTSD. Outcome was the proportion of mothers who showed symptoms of PTSD. The
effect size is the prevalence of PTSD.

We use this example to show

e How to enter data from a study that estimates a rate in one group

e How to get a sense of the weight assigned to each study

e How to perform a sensitivity analysis

How to interpret statistics for effect size

How to interpret statistics for heterogeneity

How to compute a prediction interval

The difference between a confidence interval and a prediction interval

To open a CMA file > Download and Save file | Start CMA | Open file from within CMA

Download CMA file for computers that use a period to indicate decimals
Download CMA file for computers that use a comma to indicate decimals

Download this PDF
Download data in Excel
Download trial of CMA
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Start the program

e Select the option [Start a blank spreadsheet]

o Click [OK]

E‘ Comprehensive meta analysis - [Data]

File Edit Format View [nsert Identify Tools Computational options Analyses Help
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Click Insert > Column for > Study names

E Comprehensive meta analysis - [Data]

File Edit Format VNiew | Insert Identify Tools Computational options Analyses Help
run anayses > % [ Mm "o+ 8@
2 Subgroups within study
A B plenk column Comparison names H ! d K L M
[ia Copy of selected column
_1—| Qutcome names
2 *— Blank row . .
— Time point names
3 *— Blank rows
- Copy of selected row(s) %8 Effect size data
|5 — Moderator variable
6 Y= Study r
|7
8
3
The screen should look like this
E‘ Comprehensive meta analysis - [Data]
File Edit Format View Insert Identify Tools Computational options Analyses Help
Run analyses —+ "' ﬂ|§| c',% | ﬁ| ﬁ| ’_’=| §|+'0.3 To'g H h |T_) -+ \/Dl %l El|®|
Study name B C ‘ D ‘ E ‘ F G H | ‘ J ‘ K ‘ L | 5} ‘ M
I
| =
| 3|
4
5
5
-y
8
|3
Click Insert > Column for > Effect size data
E‘ Comprehensive meta analysis - [Data]
File Edit Format Eiew|1nsert Identify Tools Computational options Analyses Help
N Moo [N o8 e
2 Subgroups within study
Study name | EEfaeimn Compari H ‘ I ‘ J ‘ K ‘ L ‘ M ‘ N ‘
Copy of selected column omparnisan names
1 Outcome names
2 A Time point names
3 *= Blank rows P
|4 Copy of selected row(s) %m
| 5| — Moderator variable
3 Y= Study T
7
g
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The program displays this wizard

Select [Show all 100 formats]
Click [Next]

Select [Estimate of means ...]
Click [Next]

Drill down to
Dichotomous (number of events)

Raw data
Events and sample size

© www.Meta-Analysis.com
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B Insert columns for effect size data

B3 Insert columns for effect size data

Welcome

If you have alieady computed the effect size [such as the
standardized mean difference or the Log odds ratio] for
each study, you may enter this information directly.

Or, vou may provide summany data (such az the number of
events of the means and standard deviations), and the
program will compute the effect size autamatically

Use thiz wizard ta specify the type of data you plan to
enter, and the program will create the required colurnns.

The program allows you to enter effect size data in maore
than one format. You will create one set of effect size
columns now, and may add additional sets at any time:

" Show commaon formats only
@ Show all 100 formats

Types of studies included

On this panel, select the type of studies to be included in
thiz meta analysis. This controls the types of data entry
options to be displayed on the next panel.

If unsure, select the first option, which iz appropriate for
most analyses. You will be able to return to this panel and
change the zelection

Comparizon of bwo groups, time-paints,
or exposures [includes corelations

Ol

{Estimate of means, proportions of rates |
iin_one group at one ime-point

Generic paint estimates

N

Generic point estimates, log scale

-
B3 Insert columns for effect size data

Click on the icons to select the data entry Format

Q One Group
E@ Dichatamaus [number of events)

m Faw data

r Everts and sample size
£] Mon-events and sample size
@ Ewents and non-events
@ Event rate and zample size

@ Confinuous [means)
0 Rates [events by person years]
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The screen should look like this

@ Comprehensive meta analysis - [Data]

File Edit Format View Insert Identify Tools Computational options Analyses Help

Run analyses —+ ?\' L = 413

¥ TR R T Y O+ v 83 ®

Events | Sample
Study naml sy

Event rate

Lagit event
rate

Std Err

Wariance

o~ || e o=

There are three options at this point

e Enter the data directly into CMA
e —or—Open the CMA data file
e —or— Copy the data from Excel

Here, we’ll show how to copy the data from Excel

e Switch to Excel and open the file “PTSD Prevalence Mothers.xls”
e Highlight the rows and columns as shown (Columns A to C only), and press CTRL-C to copy to

JH | J k. L M N o]

clipboard
A 5 PTSD Prevalence mothers.dsx - Bxcel 2 B
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT Sign it
Al - I Study
A B C D E G H J
1 |Study Events N
2 |Pelcovitz, 1996 8 37
3 |Barakat, 1997 36 400
4 |Manne, 1998 5 100
5 |Fuemmeler, 2001 12 30
6 |Libov, 2002 15 B0
7 |Brown, 2003 20 85
8 |Kazak, 2004 26 200
9 |Manne, 2004 13 120
10 |Kazak, 2005 48 200
11 |Landolt, 2005 15 70
12 |Glover n 100
13
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e Switch to CMA
e Click in cell Study-name 1

e Press [CTRL-V] to paste the data

@ Comprehensive meta analysis - [Data]

Click here

File Edit Format View Insert Identify T Computational options  Analyses Help
Runanalyses + %o [ 2 & BB E-=E NS L2+ 8 3D
Study name yms/ Szll'ggle Ewert rate Logitatte:ent StdEnr Wariance H | J K L ]
1 Events M
2| Pelcovitz, 1936 g a7 0.216 -1.288 0239 0159
3| Barakat, 1997 3% 400 0.090 2314 0175 0.031
4 Marine, 1998 5 100 0.050 -2.944 0.459 0.211
5| Fuemmeler, 2001 12 a0 0.400 -0.405 0.373 0139
6| Libov, 2002 15 a0 0188 -1.466 0.286 0.082
7| Brown, 2003 20 85 0.235 1179 0.256 0.065
8| Kazak, 2004 % 200 0130 -1.901 0.210 0.044
9| Marine, 2004 13 120 0108 -2.108 0.234 0.086
10| Kazak, 2005 48 200 0.240 1,153 0166 0.027
11| Landalt, 2005 15 70 0.214 1,239 0.291 0.085
12| Glawer 31 100 0.210 -0.800 0.216 0.047
13
14
1R
At this point we should check that the data has been copied correctly
e Click anywhere in Row 1
e Select Edit > Delete row, and confirm Click here
@ Comprehensive meta analysis - [Data]
File | Edit Format View Insert Identify Tools Computational options Analyses Help
Run; "% Bookmark data == A L e L O N A I S I [ YT
mple Lagit event .
T PSS ine Ewent rate rate Std Emr Wariahoe / | J K L 4
il = .
7|58 Copmysi=in  Enst | s 0216|  1.288 0.399 0.159
3 Copy with header 400 0.030 2314 0175 0.031
4 Copy entire grid 1a0 0.050 -2.944 0.453 021
5 a0 0.400 -0.405 0373 0139
g @ Paste S otes| e 0266 oo
7% cut Ctlex | 55 0235 1179 0.256 0.065
8 200 0130 -1.901 0.210 0.044
Delet Del
g| L Delste I ois| 2108 0.234 0.086
10 200 0.240 -1.153 0.166 0.027
1 Delete study 70 nz14 1299 0291 0085
12 Pl 100 0310 -0.800 0.216 0.047
13
14 Edit group names
15
16
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The screen should look like this

|E| Comprehensive meta analysis - [Data]

File Edit Format View Insert Identify Tools Computational options Analyses Help
Runanaryses—'%\DDqﬂ% * Eﬁa'—'= = ;?3?@8H'¢—)+\/D %iii@
Study name Events Sasli'ggle Event rate Loglﬁ:ent StdEnr Wariance H | J K L
1| Pelcovitz, 1396 g 7 0.218 -1.288 0.339 0159
2| Barakat, 1997 36 400 0.090 2314 0178 0.031
3| Manne, 1938 ] 100 0.050 -2.944 0.453 0211
4| Fuemmeler, 2001 12 30 0.400 -0.405 0.373 01339
5| Libow, 2002 15 80 0188 -1.466 0.286 0.082
E| Brown, 2003 20 85 0.235 1179 0.256 0.085
7| Kazak., 2004 26 200 0130 -1.901 0.210 0.044
8 Manne, 2004 13 120 0108 -2.108 0.294 0.026
9| Kazak, 2005 43 200 0.240 1153 0166 0.027
10/ Landolt, 2005 15 70 0214 -1.299 0.291 0.085
11| Glover il 100 0310 -0.800 0.216 0.047
12
13

By default, the program is displaying the event rate (prevalence) as the effect size

Click File > Save As and save the file

@ Comprehensive meta analysis - [Data]

File Edit Format View Insert Identify Tools Computational options Analyses Help
b 'E S % BB B =E SN -V >+ V8@
& Open Gy || Sams Event rate Lecticlen Std Err Wariance H | J K L
Opening screen wizard e rate
7 0218 -1.288 0399 0159
Import 400 0.090 2314 0175 0.03
& save Cirl+S 100 0050 -2.944 0453 0.211
a0 0.400 -0.405 0373 0133
a0 n1ag -1.4E8 0.286 0.0g2
& Print... Ctrl+P 95 0.235 1179 0.256 0.0E5
M Print setup... 200 0130 -1.501 0210 0.044
120 0108 2108 0294 0.086
Exit 200 0.240 -1.153 0166 0.027
10] Landal, 2005 15 i 0214 -1.233 0231 0.085
11 Glover # 100 0o -0.800 0216 0.047
12
13
14
15
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Note that the file name is now in the header.

e [Save] will over-write the prior version of this file without warning
e [Save As...] will allow you to save the file with a new name

|E| Comprehensive meta analysis - [C:\Users\Bigstat\Dropbox\Workshops Three-Day\PTSDVPTSD Prevalence mothers.cmal

File Edit Format View Insert Identify Toqls Computational options Analyses Help
Runanaryses—'%\DDqﬂ% * Eﬁa'—'= = ;?3?@8H'¢—)+\/D %iii@
Study name Events Sasli'ggle Event rate Loglﬁ:ent StdEnr Wariance H | J K L M
1| Pelcovitz, 1396 g 7 0.218 -1.288 0.339 0159
2| Barakat, 1997 36 400 0.090 2314 0178 0.031
3| Manne, 1938 ] 100 0.050 -2.944 0.453 0.211
4| Fuemmeler, 2001 12 30 0.400 -0.405 0.373 0139
5| Libow, 2002 15 80 0188 -1.466 0.286 0.082
E| Brown, 2003 20 85 0.235 1179 0.256 0.085
7| Kazak. 2004 26 200 0130 -1.901 0.210 0.044
8 Manne, 2004 13 120 0108 -2.108 0.294 0.026
9| Kazak, 2005 43 200 0.240 1153 0166 0.027
10/ Landolt, 2005 15 70 0214 -1.299 0.291 0.085
11| Glover il 100 0310 -0.800 0.216 0.047
12
13

To run the analysis, click [Run analysis]

@ Comprehensive metd analysis - [C:\Users\Biostat\Dropbox\Workshops Three-Day\PTSDVPTSD Prevalence mothers.cmal

File Edit Format Vi Insert Identify Tools Computational options Analyses Help
.ﬂmmm.ib’“ﬂ G % BEE—="ER RS-V >+ HHD
Study name Events Sasli'ggle Event rate LoglEazta:ent StdEn Wariance H | J K. L k4

1| Pelcovitz, 1336 g av 0216 -1.288 0.339 0159

2| Barakat, 1957 36 400 0.080 -2.314 0175 0.031

3| Manne, 1938 5 100 0.050 -2.944 0.459 0211

4| Fuemmeler, 2001 12 30 0.400 -0.405 0.373 0139

5| Liboy, 2002 15 80 0.18a -1.466 0.286 0.08z2

6| Brown, 2003 20 895 0.235 -1.179 0.256 0.065

7| Kazak, 2004 26 200 0130 -1.901 0.210 0.044

8| Manne, 2004 13 120 0108 -2.108 0.294 0.086

9| Kazak, 2005 43 200 0.240 -1.153 0166 n.0z7

10/ Landolt, 2005 15 il 0214 -1.289 0.291 0.085

11| Glaver kil 100 0.310 -0.800 0.218 0.047
12
13
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This is the basic analysis screen

Initially, the program displays the fixed-effect analysis. This is indicated by the tab at the bottom and

the label in the plot.

@ Comprehensive meta analysis - [Analysis]

File Edit Format View Computational options Analyses Help
+ Data entry +3 Next table I High resolution plot | [gh Selectby .. | = Effect measure: Event rate SEIDEETIIEE F(|lt @
Model | Study name Statistics for each study Event rate and 95% CI ‘wheight [Fixed)
Event rate | Lower limit | Upper imit | Z-4alue palue -0.50 0.25 0.o0 025 050 Fielative weight
Pelcovitz, 0.216 0112 0376 3228 0.001 —_— 34410
Barakat, 0.03n 0.066 012z -13.242 0.000 -+ 17.597 I
Manne, 0.050 0.0 0115 B417 0.000 -+ 2611
Fuemmeler, 0.400 0.243 0581 -1.088 0.277 350
Libov, 2002 0188 0116 0288 118 0.000 — 665 Il
Erown, 0.235 0157 0337 -4.609 0.000 —H— 239 Il
K.azak, 0130 0.030 0184 -9.041 0.000 —— 1241
Manne, 0108 0.084 017s FAT? 0.000 — 635 Il
Kazak, 0.240 0186 0304 £.962 0000 —— 2001
Landalt, 0.214 0134 0326 -4.460 0.000 — 645 Il
Glover 0310 0.227 0.407 -3.700 0.000 T— 11.73 Il
Fixed 0178 0158 0201 -20.631 0.000 ==

The p-value tests the null that the true effect size is 0.50.
value and the p-value.

Right-click on the statistics.

@ Comprehensive meta analysis - [Analysis]

This is of no interest to us, so we’ll hide the z-

File Edit Format View Computational options Analyses Help
+ Data entry +73 Next table b High resolution piot | [gh Selectby .. | - Effect measure: Event rate EEETTIRE F| &2 @
Model | Study name Statistics for each study Event rate and 95% Cl ‘wigight [Fixed)
Eventrate | Lower it | Upper limit | Z-4alue palue -0.50 -0.25 0.00 025 050 Relative weight
Pelcovitz, 026 0112 0.376 -3.225 0.om | —_— 3440
Barakat, 0090 0.065 0122 13.242 nnnn -+ 17.97
tanne, 0.050 0.04 0115 £.417 %l Sort Lo-Hi by p-Value —+ 26110
F.uemmeler, 0.400 0243 0.581 1.088 Z| Sort Hi-Lo by p-Value 3950
Liba, 2002 0188 0118 0.288 5114 — 6.65 Il
Erown, 0235 0157 0337 4,609 22 Show/hide basic stats —r— EES] |
K.azak, 0130 0.030 0184 -9.041 — 1241
Manne, 0108 0.064 017e T — .26 Il
Kazak, 0240 0186 0.304 £.952 ] —— 20.01
Landalt, 0214 0134 0.326 -4 460 0.000 — T &.45 Il
Giloever 03 0227 0.407 -3.700 0.000 i — 11.73
Fixed 0173 0158 0.20m 20631 0.000 ==
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e Remove check-marks for Z-value and p-value
e Click Ok
@ Comprehensive meta analysis - [Analysis]
File Edit Format View Computational options Analyses Help
4 Data entry 1+ Mext table } High resolution plot | [gly Select by =+ Effect measure: Event rate < IE‘ I:‘ ;E TT E- E F| @
fdodel Study name Statistics for each study Ewent rate and 95% C| Weight [Fiked)
Eventrate | Lower limit | Upper limit | Z4alue palue -0.50 -0.25 oon 025 050 Relative weight
Pelcovitz, 0216 0112 0.376 3,225 0.001 | | | —o—’— | 344 1
Barakat, 0.090 (0.0E6 0122 -13.242 0.000 | = 174
Manne, 0.050 0.0z 0115 6417 0.000 B Customize display
Fuemmeler, 0.400 0.243 0.581 -1.085 0.277
Libov, 2002 0188 0116 0.2a8 5114 0.0o0 Show Decimalz  Alignment
Eirowan, 0.235 0157 0.337 -4.603 0.000
Kazak. 0130 0.030 0154 -9.041 0.000 — ,—_|
Manne, 0.108 0.0# 078 AT 0.000 & sl | z
Kazak, 0.240 0186 0.304 -6.962 0.000 r
Landalt, 0214 0134 0.328 -4 460 0.000 ,—_|
Blover 0310 027 0407 3700 0000 o BrEE s ] [euro =1 )
Fixed 0178 0158 0.2 -20.631 0.000 W Standard emmor futo w| |Auto =
¥ ariance Auto v | |Auto -
Iv  Lower limit Auto v | |Auto -
[+  Upper limit Autg w | |Auto -
[T ZVale Auto v | |Auto A
[T pWalue Autg w | |Auto -
Cancel Apply | Ok |
@ Comprehensive meta analysis - [Analysis]
File Edit Format View Computational options Analyses Help
+ Data entry 13+ Next table :{— High resolution plot % Select by ... | =+ Effect measure: Event rate < |E| I:‘ EE TT :{- E :E ’j @
Model Study name Statistics for each study Event rate and 95% C Weight [Fixed]
Ewentrate | Lower limit | Upper limit -0.50 025 0.00 025 050 Relative weight
Peloovitz, 1936 0216 011z 0376 —_— 34410
Barakat, 1937 0.030 0.068 012z -+ 17.57 I
Manne, 1333 0.050 0.0 0115 - bl |
Fuemmeler, 0.400 0.243 0.581 ey |
Libow, 2002 n1gs 0116 0.283 — 663
Erown, 2003 0235 0157 0337 —H— 233 Il
K.azak, 2004 0130 0.030 0184 —— 1241
Manne, 2004 0108 0.064 0178 — 635
Kazak, 2005 0.240 0186 0.304 —H— 20.01
Landalt, 2005 0214 0134 0326 — 645
Glower 0.310 0.2z7 0.407 T— 11.73
Fired 0178 0158 0201 -+
© www.Meta-Analysis.com PTSD — 10—
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Click [Both models]

The program displays results for both the fixed-effect and the random-effects analysis.

@ Comprehensive meta analysis - [Analysis]

File Edit Format View Computational options Analyses Help
4 Data entry +} Next table } High resolution plot | Egly Select by =+ Effect measure: Event rate < IE‘ I:‘ EE TT $ E F| @
fdodel Study name Statistics for each study Ewent rate and 95% CI Wieight [Fived) Wieight [Fandam]
Ewentrate | Lower limit = Upper limit -0.50 025 o.00 0.25 0.50 Relative weight Relative weight

Pelcovitz, 1996 0.216 0112 0.376 e 3440 770 Il
Barakat, 1337 0.030 0.066 0122 -+ 17.97 I 10.34
Manne, 1333 0.050 0.021 01s - 26110 7.00 Il
Fuemmeler, 0.400 0.243 0.581 2950 2.03 Il
Libov, 2002 0188 0116 0.258 — 665 Il 310
Brown, 2003 0.235 0157 0.337 — 239 Il 347
Kazak, 2004 0130 0.030 0154 — 1241 I 9.93 N
anne, 2004 0108 0.064 0178 — 6.35 Il 201 Il
Kazak, 2005 0.240 0186 0.304 —— z0.01 10.43
Landolt, 2005 0.214 0134 0.326 — T 6.45 Il 2.04
e 0.310 0.227 0.407 4 1173 931

Fixed 0178 0158 n.2m -+

Fandom 0180 0130 0.244 ——

Under the fixed-effect model the pooled estimate is 0.178, while under the random-effects model the
pooled estimate is 0.180. While the estimate of prevalence happens to be almost identical under the
two models, the precision of the estimate is very different.

e The fixed-effect model would be appropriate if all the studies were virtual replicates of each
other. This is not the case here since the patients varied in important ways from study to study.

e The random-effects model would be appropriate if the studies vary in ways that may impact the
effect size (such as those mentioned immediately above). Therefore, we will use the random-
effects model.

© www.Meta-Analysis.com PTSD — 11—
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e Click Random on the tab at the bottom

The plot now displays the random-effects analysis alone.

@ Comprehensive meta analysis - [Analysis]

File Edit Format View Computational options Analyses Help
+ Data entry 13 Next table - High resolution plot | [gh Selectby ... | =+ Effect measure: Event rate EILIETIFE F| 2 @
Model Study name Statistics for each study Ewent rate and 95% C| ‘wieight [Random)]
Ewvent rate | Lower lirit | Upper limit 050 0.25 0.00 025 050 Relative weight

Pelcavitz, 1996 0216 0112 0.376 —_— 770 I
Barakat, 1997 0.090 0.066 o122 -+ 10.34 [N
Manne, 1938 0.0s0 0.0 0118 —+— 700
Fuemmeler, 0.400 0243 051 2.0z Il
Liboy, 2002 n1ae 0116 n.zes — 210 1l
Browe, 2003 0.235 0157 0337 — 3.47 I
K.azak, 2004 0130 0.090 0184 —— 9.5 Il
Manne, 2004 0108 0.064 0178 — 301
K.azak, 2005 0.240 0186 0.304 —— 10.43 N
Landalt, 2005 0214 0134 0.326 — 9.04
Glover 0310 n0.zz27 0.407 T 39

Fandom 0180 0130 0.244 ——

A quick view of the plot suggests the following

The risk of PTSD varied substantially from study to study.
The risks vary from a low of 5.0% to a high of 40.0%

It seems that much of this variation reflects differences in real proportions

The mean prevalence is 0.180 with a Cl of 0.130 to 0.244

© www.Meta-Analysis.com PTSD
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Click [Next table]

Click here

@ Comprehensive meta analysis - [Analysis]

4 Data entry

File Edit Format g% ptions Analyses Help
3 Next table’ High resolution piot | [h Selectby .. | 4 Effect measure: Event rate EIC|EEIIFE F| v @

Model

S

Effect size and 95% interval Test of null [2-Tail) Heterogeneity Tau-squared

Model

Fired
Fiandom

Figure 1

Number Point Lower Upper Tau Standard
Studies estimate limit limit Z-value  P-value B-value df [@) P-value I-squared Squared Error Variance Tau

1" 0178 0158 o.2m 2063 0.000 BR229 10 0.000 84 ER3 0346 0.204 0o n5aa
1l 0180 0130 0.244 -7.695 0.000

The statistics at the left duplicate those we saw on the prior screen.

Under the random-effects model the mean prevalence is 0.180 with a 95% confidence interval
of 0.130 to 0.244.

The statistics at the upper right relate to the dispersion of effect sizes across studies.

The Q-value is 65.229 with df=10 and p< 0.001. Q reflects the distance of each study from the
mean effect (weighted, squared, and summed over all studies). Q is always computed using FE
weights (which is the reason it is displayed on the “Fixed” row, but applies to both FE and RE
analyses.

If all studies actually shared the same true effect size, the expected value of Q would be equal to
df (which is 10). Here, Q is greater than that value, and so there is some evidence of variance in
true effects. This excess variance falls outside the range that could be attributed to random
variation in effects (it is statistically significant).

We had planned to use the random-effects model, since this matches the sampling frame for
the studies, and would do so whether or not the Q-value was statistically significant.

T2 is the estimate of the between-study variance in true effects. This estimate is 0.346. T is the
estimate of the between-study standard deviation in true effects. This estimate is 0.588. These
value are both in logit units.

I reflects the proportion of true variance to observed variance. This is 84.669, which tells us
that about 85% of the observed variance in effects is real. Put another way, if we were looking
at a plot of the true effects rather than the observed effects, the variance in effects would be
decreased by (1 minus .85) some 15%.

This high value of 12 tells us that if we could plot the true prevalence for each study, the
dispersion would be only a little smaller than the dispersion we see in the plot of observed
effects.

© www.Meta-Analysis.com PTSD — 13 —
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We can use the spreadsheet [Prediction intervals] as follows

Open the spreadsheet [Prediction Intervals.xls]

Select the tab for [Prevalence]
In CMA selec
Copy the A|B|C|D value

rate as the index

as shown from CMA to Excel

[] Comprehensive meta analysis - [Analysis] (=11
File Edit Format View Computational options Analyses Help \
+ Data entry +3 Hext table - High resolution piot | [gly Select + Effectmeasure: Logteventrate  ~J=| [ ]|Z2 7T/ E F |1 @
J
Model Effect size and 95% confidence interval Test of null (2-Tail) Heterogeneity Tau-squared
Humber  Point  Standaid Lower  Upper Tau  Standaid
Model Studies estimate aror Variance limit limit Z-value P-value Q-value df [Q) P-value I-squared Squared Emor Variance Tau
Fined Mmoo 005 67 9m 267 00w 65,229 0 oom B4EE9 036 02 00A 0508
Random R R 1T R T 1R e - S R € 7695 00w T
A I B D
Figure 2
H - = Prediction intervals.xlsx - Excel
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT
03 - =
A B C D F G H
1 Prediction intervals for prevalence
2
3 Enter values in shaded cells only
4 Values must be entered in logit units
5
6 Number of studies 11 A
7 Degrees of freedom 9 p. 130
8 Critical value for ¢ (95% interval) 2.262157 p. 131
9 Mean effect (random effect weights) in logit units -1.519 12.7 B
10 Tau-squared in logit units 0.346 16.5 C
11 Variance of M * in in logit units 0.039 12.8 D
12 |
13 Prediction interval in logit units
14 Mean -1.519000
15 Prediction interval (95%) lower limit -2.922632 17.7
16 Prediction interval {95%) upper limit -0.115368 17.8
17
18 Prediction interval in prevalence units
19 Mean 0.179609
20 Prediction interval (95%) lower limit 0.051046
21 Prediction interval (95%) upper limit 0.471190
22
© www.Meta-Analysis.com PTSD — 14 —
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The confidence interval is 0.130 to 0.244 (read this from Figure 1, where the index is the event rate
rather than the logit). The prediction interval (from Excel) is 0.051 to 0.471.

The true prevalence size varies from study to study. The mean prevalence probably falls in the range of
0.130 to 0.244. The true effect size for any single study will usually fall in the range of 0.051 to 0.471.

In 95% of all possible meta-analyses, the true mean will fall in the range indicated by the Cl. In 95% of all
meta-analyses, 95% of all studies will fall inside the range indicated by the PI. This assumes that the true
effect sizes are normally distributed.

e Click [Next table] to return to the main analysis screen
e Click Hi-Resolution plot
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Summary

This analysis includes eleven studies where mothers whose children suffered with chronic illnesses were
evaluated for PRSD. Outcome was the proportion of mothers who showed symptoms of PTSD. The
effect size is the prevalence of PTSD.

What is the pooled estimate of prevalence?

The pooled estimate of prevalence is 0.180, which means that about 18% of the mothers showed
symptoms of PTSD.

These studies were sampled from a universe of possible studies defined by certain inclusion/exclusion
rules as outlined in the full paper. The confidence interval for the prevalence is 0.130 to 0.244, which tell
us that the mean prevalence in the universe of studies could fall anywhere in this range.

The Z-value tests the null hypothesis that the mean prevalence is 0.500, which is not of interest here.
Does the effect size vary across studies?

The observed effect size varies somewhat from study to study, but a certain amount of variation is
expected due to sampling error. We need to determine if the observed variation falls within the range
that can be attributed to sampling error (in which case there is no evidence of variation in true effects),
or if it exceeds that range.

The Q-statistic provides a test of the null hypothesis that all studies in the analysis share a common
effect size. If all studies shared the same effect size, the expected value of Q would be equal to the
degrees of freedom (the number of studies minus 1).

The Q-value is 65.229 with 10 degrees of freedom and p < 0.001. We can reject the null hypothesis that
the true effect size is the same in all these studies.

The P statistic tells us what proportion of the observed variance reflects differences in true effect sizes
rather than sampling error. Here, 12 is 84.669. This tells us that about 85% of the variance in observed
rates reflects variance in true rates rather than sampling error.

T2 is the variance of true effect sizes (in logit units). Here, T?is 0.346. Tis the standard deviation of true
effects (in logit units). Here, Tis 0.588.

If we assume that the rates are normally distributed (in logit units) we can estimate that the prediction
interval. The true effect size for any single study will usually fall in the range of 0.051 to 0.471.
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